
  

Do not delete 

 

Communications Division 

MediaAgent User Manual  

 Models VR615, VR725, VR778, NexLog 740 and NexLog 840  

 NexLog Recorder Software v2.1 or Atlas Recorder Software v1.9 or later 

[NOTE: Information on title page comes from variables at top of document. Do not directly edit 
or delete the text produced by these fields. Instead, reveal hidden text & change the 
variable. ] 

  [< DO NOT DELETE this draft information paragraph or anything in it, even if it is blank. Set it 
using the d_DraftInfo variable. To remove for publication, change it to a blank space.]  

[DO NOT DELETE THIS ANCHORING PARAGRAPH FOR Title_PNdate FRAME.>]  

 Part Number: 141115–05 

 Published: April 30, 2012 



 

ii   MediaAgent User Manual v2.1   

© 2004 – 2010 Eventide Inc. ALL RIGHTS RESERVED. 

Every effort has been made to make this guide as complete and accurate as possible, but Eventide 
Inc. DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. The information provided is on an “as-is” basis and is subject to change without notice or 
obligation. Eventide Inc. has neither liability nor responsibility to any person or entity with respect to 
loss or damages arising from the information contained in this guide. 

Notice: This computer program and its documentation are protected by copyright law and 
international treaties. Any unauthorized copying or distribution of this program, its documentation, or 
any portion thereof may result in severe civil and criminal penalties. 

The software installed in accordance with this documentation is copyrighted and licensed by Eventide 
Inc. under separate license agreement. The software may only be used pursuant to the terms and 
conditions of such license agreement. Any other use may be a violation of law.  

Eventide is a registered trademark of Eventide Inc. 

* Other names and brands may be claimed as the property of others. 

 

Publication Date: April 30, 2012  

Document Number: 141115–05 

Publisher: Eventide Inc., Communications Division, 1 Alsan Way, Little Ferry, NJ 07643, 
telephone: 201-641-1200 

 

Communications Division Product Information: Visit the Eventide website at:  
www.eventide.com.  

Communications Division Product Service and Technical Support:  
 Users: Contact your local authorized Eventide Dealer (locate a dealer on the Eventide website).  
 Authorized Dealers: Visit the Eventide website or email support@eventide.com.  

 
 

http://www.eventide.com/
mailto:support@eventide.com


 

 MediaAgent User Manual v2.1 Contents  iii 

  

Contents  
 

Revision History ............................................................................................................................. 1 

1.  MediaAgent Overview ................................................................................................................ 3 

1.1.  The Main Window ............................................................................................................... 3 

2.  Getting Started ........................................................................................................................... 5 

2.1.  Installing MediaAgent .......................................................................................................... 5 
2.2.  Starting MediaAgent and Adding a Source .......................................................................... 5 
2.3.  Locating and Playing Records ............................................................................................. 7 

3.  MediaAgent User Interface ........................................................................................................ 9 

3.1.  The Menu Bar ..................................................................................................................... 9 
3.1.1.  File ........................................................................................................................... 9 
3.1.2.  Playback ................................................................................................................ 10 
3.1.3.  Tools ...................................................................................................................... 11 
3.1.4.  Help ....................................................................................................................... 11 

3.2.  Options Menu .................................................................................................................... 13 
3.2.1.  Sources Options..................................................................................................... 14 
3.2.2.  General Options ..................................................................................................... 15 
3.2.3.  Channel Groups Options ........................................................................................ 16 
3.2.4.  Filters Options ........................................................................................................ 16 
3.2.5.  Instant Recall Options ............................................................................................ 17 
3.2.6.  Playback Options ................................................................................................... 17 
3.2.7.  Default Columns Options ....................................................................................... 18 
3.2.8.  Video Options ........................................................................................................ 18 
3.2.9.  Change Password Options ..................................................................................... 18 

4.  Using MediaAgent .................................................................................................................... 19 

4.1.  Locating and Organizing Records ..................................................................................... 19 
4.2.  Creating Filters .................................................................................................................. 20 

4.2.1.  Setting Tabs ........................................................................................................... 20 
4.2.2.  Setting the Time Range .......................................................................................... 20 

4.3.  Updating Records ............................................................................................................. 21 
4.3.1.  Properties Screen .................................................................................................. 21 

4.4.  Viewing and Playing Records ............................................................................................ 23 
4.4.1.  Viewing Records .................................................................................................... 23 
4.4.2.  The Record View .................................................................................................... 23 



 

iv  Contents MediaAgent User Manual v2.1   

4.4.3.  Playing Audio or Video Records ............................................................................. 25 
4.4.4.  The Playback Console ........................................................................................... 27 

4.5.  Exporting Record Data ...................................................................................................... 28 
4.6.  Monitoring Recorders ........................................................................................................ 29 

4.6.1.  Instant Recall Tab .................................................................................................. 29 
4.6.2.  Channels Tab ......................................................................................................... 31 
4.6.3.  Recorders Tab ....................................................................................................... 32 

5.  Frequently Asked Questions................................................................................................... 34 

6.  Reporting Problems ................................................................................................................. 35 

 



 

 MediaAgent User Manual v2.1 Revision History    1 

  

Revision History 

This section summarizes significant changes, corrections, and additions to the document. The 

history appears in chronological order with the most recent document listed first. Documents 

are identified by part number and applicable software (SW) version. 

This section tracks documentation changes. For a description of new software features and 

improvements introduced in a particular release, see the product release notes on the Eventide 

company website. 

March 30, 2012 

Part Number SW Description 

141115–05 v2.1 General release for v2.1. 

June 29, 2011 

Part Number SW Description 

141115–04 v2.0 General release for v2.0. 

June 23, 2010 

Part Number SW Description 

141115–03 v1.9.5 General release for v1.9.5. 
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October 29, 2009 

Part Number SW Description 

141115–02 v1.9.1 Clarified the use of the Play button and Space bar in the following sections: 

 Section 2.3.  Locating and Playing Records 

 Section 4.4.3.  Playing Audio or Video Records 

Revised the description of the Play selected (Return key) menu item in the following 
section: 

 Section 3.1.2.  Playback 

 

May 21, 2009 

Part Number SW Description 

141115–01 v1.9.0 Initial version of this document. Much of the information in this document was previously 
in the MediaAgent v1.8 User Manual (published April 15, 2008). 

  Global changes: 

 Standardized the page design and presentation of information. 

 Reorganized content to improve clarity and understanding. 

 Changes and additions for v1.9: 

 Video – added information to support this feature. See Section 4.4.3.  Playing Audio or 
Video Records. 

 Export Media – added new information to support this feature. See Section 
4.5.  Exporting Record Data. 

Notice Regarding Prior Documents 

Revision history was not tracked for documents prior to May 21, 2009 (141115–01, v1.9.0). 
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1.  MediaAgent Overview 

The Eventide® MediaAgent™ application allows you to monitor audio and video 

data from Eventide recorders. You can locate records by time and channel (or 

groups of channels). Once found, you will be able to listen to and export the 

data. 

 Note: The term video applies to both screen capture data and video data. 

MediaAgent is primarily an instant recall client with a set of additional 

monitoring tools. It is geared toward users who need to quickly locate the most 

recent data on their recorders. As records appear on a recorder, MediaAgent will 

display the new record data in real time. Once records are displayed, they can be 

examined, updated, and listened to. MediaAgent can also monitor different 

aspects of the recorders, including live feeds and system alerts and status. 

1.1.  The Main Window 

The MediaAgent Main window, Figure 1, is the primary workspace for interfacing 

to a recorder using MediaAgent. The main window uses tabs located across the 

top of the window to organize information. Clicking a tab will cause that tab to 

become active. The default main window includes the following tabs: 

 Instant Recall Tab (See Section 4.6.1.  Instant Recall Tab.) 

 Channels Tab (See Section 4.6.2.  Channels Tab.) 

 Recorders Tab (See Section 4.6.3.  Recorders Tab.) 
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Figure 1. MediaAgent Main Window 
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2.  Getting Started 

The following topics provide information about installing the MediaAgent 

software and helping you to quickly understand and begin using the MediaAgent 

application: 

 Section 2.1.  Installing MediaAgent 

 Section 2.2.  Starting MediaAgent and Adding a Source 

 Section 2.3.  Locating and Playing Records 

2.1.  Installing MediaAgent 

From the Eventide Client software CD, double-click on the installation MSI file. 

This will launch the MediaAgent installer. Follow the prompts to install the 

MediaAgent application. 

By default, MediaAgent will install to the Eventide/MediaAgent directory where it is 

accessible to all users on your system. This version of MediaAgent can be 

installed over previous installations. 

You may change the location by clicking the Browse button and selecting a new 

location, but it is recommended that you accept the default installation location. 

When the installation is complete, a MediaAgent icon will display on your 

desktop. Additionally, during installation a ..mediaajent directory is created in 

your User Documents and Settings directory. 

 Note: If this is an upgrade installation, all previous configuration files will 

automatically be upgraded the first time MediaAgent is run. 

2.2.  Starting MediaAgent and Adding a Source 

When starting MediaAgent for the first time, you will be prompted, Figure 2, to 

add a source. A source is an Eventide NexLog, Atlas Series or DIR911t recorder. 
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Figure 2. Add a Source Prompt 

 

Select Yes and the Options screen, Figure 3, will be displayed. 

Figure 3. Options Screen 

 

Use the following procedure to add one or more recorders: 

1. Select Sources from the list in the box on the left side of the screen. 

2. Click the Add button. The Add source dialog box will appear (see Figure 4). 

Figure 4. Adding a Source 

 

3. Enter the IP address or host name of the recorder in the Server: box. 
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4. Enter your user name in the User: box. 

5. Enter your password in the Password: box. If you would like MediaAgent to 

remember your password, check the Remember Password box. 

6. If you are connecting to a NexLog recorder which has SSL enabled for client 

connections, check the Use SSL box to make a secure connection with the 

recorder. 

7. Click the OK button. The source will now appear in the Sources box. 

8. After connecting to a source, close the Options dialog box. 

 Note: After your initial MediaAgent session, if you did not initially check the 

Remember Password box, each time you start MediaAgent you will be promted to 

reconnect to a source (or sources) to which you had been previously connected. 

At each prompt, enter your password to connect to the respective source. 

For additional information about adding a source, refer to Section 

3.2.1.  Sources Options. 

2.3.  Locating and Playing Records 

The quickest way to locate records is to choose a channel with activity from the 

‘Instant Recall’ Tab, which is initially displayed, Figure 5. Select a time frame 

(suitably a few hours in the past) and the records will be retrieved and displayed. 

Figure 5. Instant Recall Tab 
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Once records are displayed, press the Play button located in the Playback 

Controls at the bottom of the screen, Figure 6. The first record in the list will 

begin playing. To play a different record, highlight the new record and press the 

Enter key or double-click on the new record. Information about the currently 

playing record will be displayed above the playback controls at the bottom of the 

screen. You can adjust the volume and playback speed, or change playback 

position (scrub) within the record using the playback controls. For more 

information, see Section 4.4.4.  The Playback Console. 

Figure 6. Playback Controls 

 

After retrieving records, a number of options are available. In addition to 

listening to the audio or viewing the video, you can export the data to disk. See 

Section 4.5.  Exporting Record Data. Numerous other monitoring tools are 

available from within MediaAgent, including: 

 Instant Recall (see Section 4.6.1.  Instant Recall Tab) 

 Live channel monitoring (see Section 4.6.2.  Channels Tab) 

 Alarm monitoring (see Section 4.6.3.  Recorders Tab) 
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3.  MediaAgent User Interface 

In addition to the Main window, MediaAgent includes a Menu bar containing a 

number of sub-menu items that let you perform a number of tasks. Also, one 

selection from the Menu bar is the Options sub-menu item, selected from the 

Tools menu, which provides additional capability for using the MediaAgent 

application. 

The following sections describe the MediaAgent user interface: 

 Section 3.1.  The Menu Bar 

 Section 3.2.  Options Menu 

3.1.  The Menu Bar 

The Menu bar is located at the top of the MediaAgent window. A number of 

menu selections have shortcut keys associated with them and are displayed to 

the right of the menu selection. Also, if a menu selection includes an associated 

shortcut key, the shortcut key is shown parenthetically in the following 

descriptions. 

The Menu bar includes the following menu items: 

3.1.1.  File 

Selecting File from the Menu Bar provides the following menu items: 

New Tab 

The New Tab menu item opens a new tab in the active top-level window. Choose 

a tab name from the list that appears. The list includes: 

 Instant Recall (Ctrl+R) 

 Channels (Ctrl+L) 

 Recorders (Ctrl+E) 
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Close Tab (Ctrl+W) 

This menu item closes the active tab on the active top-level window. You cannot 

close the last tab on a window. 

Exit (Ctrl+Q) 

Selecting the Exit menu item closes all top-level windows and exits the 

MediaAgent program. 

3.1.2.  Playback 

Selecting Playback from the Menu Bar provides the following menu items: 

Toggle Playback (Space bar) 

Checking this box starts playback. Un-checking this box stops playback. 

Play Selected (Return key) 

The Play Selected menu item starts playback on the selected record. If there is 

no selection, the first record in the list will begin playing. 

Next Record (Shift+Right arrow) 

The Next Record menu item skips to the start of the next record as listed in the 

Record view. 

Previous Record (Shift+Left arrow) 

Selecting Previous Record skips to the previous record as listed in the record 

view, or skips to the beginning of the current record, depending on the time that 

the current record has been playing. If the current record has been playing for 

less than 3 seconds, it will skip to the previous record. If the current record has 

been playing for more than 3 seconds, it will skip to the beginning of the 

currently playing record. 

Skip Forward (Right arrow) 

The Skip Forward menu item scrubs forward by a user-defined number of 

seconds (default is 10). Scrubbing remains within the bounds of the currently 

playing record. 
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Skip Back (Left arrow) 

The Skip Back menu item scrubs backward by a user-defined number of 

seconds (default is 10). Scrubbing remains within the bounds of the currently 

playing record 

Loop Playback 

Checking the Loop Playback box loops playback between user-defined start and 

end looping points. If no user-defined start and end looping points have been 

set, the entire record will be looped. If start and end points have been set within 

the record, checking Loop Playback will initiate loopback between these two 

points. 

3.1.3.  Tools 

Selecting Tools from the Menu Bar provides the following menu items: 

Refresh (F5) 

The Refresh menu item refreshes the list of records in the active tab. 

Options… 

The Options… menu item opens the MediaAgent Options dialog box, where 

various applications settings can be adjusted. For additional information about 

the Options dialog box, see Section 3.2.  Options Menu. 

3.1.4.  Help 

Selecting Help from the Menu Bar provides the following menu items: 

Contents… 

Selecting Contents… from the Help menu activates the MediaAgent HTML 

Online Help, Figure 7. This allows you to access MediaAgent topics from the 

Contents, Index, or Search tabs. 
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Figure 7. Contents Online Help 

 

Frequently Asked Questions… 

Selecting Frequently Asked Questions… from the Help menu invokes the 

MediaWorks Frequently Asked Questions help. 

What’s this? (Shift+F1) 

Selecting What’s this? from the Help menu or pressing the Shift + F1 keys 

displays a question mark (?) to the right of the cursor. Moving the question mark 

to an area of the screen and then clicking will display a brief explanation about 

the selected field or screen area. See Figure 8. 
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Figure 8. What’s This? Online Help 

 

About 

Selecting About from the Help menu provides information about this release of 

MediaAgent. 

3.2.  Options Menu 

The Options menu, Figure 9, provides a number of options for working with 

MediaAgent. Through the Options menu, you can perform a number of tasks 

and adjustments to MediaAgent. 



 

14  Chap. 3.  MediaAgent User Interface MediaAgent User Manual v2.1   

Figure 9. Options Window 

 

The options include the following: 

3.2.1.  Sources Options 

This option allows you to add or remove a MediaAgent source or, once added, to 

disconnect and reconnect to a source. To add a new connection to a NexLog or 

Atlas Series recorder or to an offline archive, click the Add button. In the Add 

source dialog box that appears, enter the following: 

 Source: Enter the IP address or host name of the recorder (or file path to an 

offline archive) to which you wish to connect. 

 User: Enter your user name if connecting to a recorder. 

 Password: Enter your password if connecting to a recorder. 

Then click the OK button to add the selected source. 

 Note: When adding a source, you can optionally instruct MediaAgent to remember 

your password. Then, in the future, MediaAgent will log you in to the source 

immediately, without prompting for a password. 

All connected resources will be reconnected when restarting MediaAgent. 

To completely remove a source from the list, select the source and then click the 

Remove button. 

After a source has been added, you can connect and disconnect from any source 

in the list, as necessary, without having to go through the process of adding a 

source. To disconnect from a source, select the source and click the Disconnect 

button. To reconnect to that source, select the source and click the Connect 

button. 
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3.2.2.  General Options 

The General options allow you to modify MediaAgent general application 

settings. These include: 

Minimize to system tray 

Check this box to prevent MediaAgent from shutting down when closing the 

main window. Instead of exiting the application, MediaAgent will be minimized 

to the system tray of the task bar. MediaAgent can be easily restored by double-

clicking on the system tray icon or right-clicking and choosing “Restore 

MediaAgent”. 

Play first track on double-click restore from system tray 

Check this box to have the first track in the active Instant Recall window begin 

playing if you double-click to restore MediaAgent from the system tray. 

Notify when new Alarms appear 

Enable this selection to be notified of new alarms on any of your connected 

sources.  

Do not notify on Recorders tab 

Check this box if you have the Recorders tab open often and you do not want 

the duplicate alarm notification. 

Make notifications audible 

Enable this option to have a sound play when the Alarm notification box is 

visible. 

Audible alert sound 

You may choose any of the following default system sounds, or choose your own 

sound to be played, if Make notifications audible is enabled: 

 Exclamation 

 Asterisk 

 Default Beep 

 Hand 

 Question 
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 Choose a file from disk… 

Repeat audible alert (every 5 seconds) 

Enable this option to have your chosen sound loop for as long as the Alarm 

notification message box is visible. 

Elevate Configuration Button 

Click on this button to copy your current MediaAgent configuration to the 

machine defaults. You must have Administrator privileges to perform this 

function. 

3.2.3.  Channel Groups Options 

A Channel Group is a collection of one or more channels. MediaAgent uses 

Channel Groups in the Instant Recall tabs. 

In the Instant Recall tab, Channel Groups can be selected as the active filter. 

This allows Instant Recall to monitor more than one channel at a time. 

To create a new Channel Group, select Channel Groups from the Options list. 

The Options dialog box will display a Sources list and a Groups list. Click on the 

Add Group button. You will be prompted to enter a Group Name. After the 

group has been created, it is initially empty. Add channels to the group by first 

selecting one or more channels from the Sources list on the left. Then click on 

the arrow button in the center to add the selected channels to the group. You 

can add channels from a different source by selecting another source from the 

drop-down list above the channel list. 

You can edit an existing Channel Group by selecting it from the Groups list on 

the right. Remove individual channels from a group by first selecting them and 

then clicking the Remove Channel button. You can remove an entire Channel 

Group by selecting the group and clicking the Remove Group button. 

3.2.4.  Filters Options 

Filters are used in Instant Recall to limit the live record view. A filter is a single 

channel name, or Channel Group. Use the Filters option to define which filters 

are visible in an Instant Recall tab. 

To add a Channel Name filter, select one or more channels from the Channels 

list and click on the associated arrow button. To add a Channel Group filter, 

select one or more groups from the Groups list and click on the associated arrow 

button. 
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The order in which the filters appear in the Instant Recall tab can also be 

adjusted. To change the order of filters, select one or more filters from the 

Visible list and then click the up or down arrow to change the relative order. 

To prevent a filter from showing up in the Instant Recall, select the filter from 

the Visible list and click the Remove Filter button. 

3.2.5.  Instant Recall Options 

Instant Recall allows you to monitor recent channel activity. There is, however, a 

maximum record limit to each Instant Recall tab. The Instant Recall options 

include the following: 

Maximum Records 

Use the up or down arrows to increase or decrease the Maximum Records 

value. It is recommended that this value be left at the default setting of 5000 or 

lower as increasing the number may impact performance. 

Hours/Minutes (Display Time) 

Each Instant Recall tab contains a default time window, within which records 

are displayed. Use the up or down arrows to increase or decrease the Hours: 

and Minutes: values. 

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

3.2.6.  Playback Options 

The Playback options allow you to adjust global playback behavior. 

Ignore Audio Discontinuities 

Certain analog capture boards are occasionally prone to small continuity jitter, 

while recording audio. To suppress warnings about these audio anomalies, 

check the Ignore Audio Discontinuities box. To see all audio continuity 

warnings while playing audio, leave this box unchecked. 

Skip Interval 

Adjust the Skip Interval to specify the number of seconds to be scrubbed forward 

or backward when using the Skip Forward or Skip Back menu selections from the 

Playback menu (See Section 3.1.2.  Playback) or the skip forward (>>) or skip 

back (<<) controls on either side of the slider in the Playback Console (see 

Section 4.4.4.  The Playback Console). 
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3.2.7.  Default Columns Options 

The Default Columns option allows you to specify the default columns 

displayed when opening a new Instant Recall tab. From the available column list 

on the left, select a column to add and click the right arrow button. The column 

will then move to the box on the right. To remove a column, select one from the 

list on the right and click the left arrow button. The order in which the default 

columns are displayed can be changed; select a column from the list on the right 

and adjust its position by clicking on the up or down arrow button. 

3.2.8.  Video Options 

The Video options allow you to include the time in the video display. 

Show Time in the video display 

Check this box to include the time, as defined in the Recorder Setup 

configuration, in the video display. 

Show UTC time in the video display 

Check this box to show the time as Universal Time Coordinated (UTC, a.k.a. 

Greenwich mean time) in the video display. 

3.2.9.  Change Password Options 

For those sources that support it, your current password can be changed. Select 

a source from the list and enter your new password in the New password: box. 

Enter the new password again in the Repeat new password box and then click 

on the Apply button. Your password will now be changed on the source 

recorder. 
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4.  Using MediaAgent 

MediaAgent is geared toward users who need to quickly locate the most recent 

data on their Eventide recorders. As records appear on the recorder, MediaAgent 

will display the new record data in real time. Once records are displayed, they 

can be examined, updated, and listened to. 

MediaAgent can also monitor different aspects of your Eventide recorders, 

including live audio feeds and system alerts and status. 

The following sections provide information about using the MediaAgent 

application: 

 Section 4.1.  Locating and Organizing Records 

 Section 4.2.  Creating Filters 

 Section 4.3.  Updating Records 

 Section 4.4.  Viewing and Playing Records 

 Section 4.5.  Exporting Record Data 

 Section 4.6.  Monitoring Recorders 

4.1.  Locating and Organizing Records 

The process for finding and organizing records includes the following steps: 

 Creating filters that encompass one or more channels on the recorder. See 

Section 4.2.  Creating Filters. 

 Creating a new tab for each filter. See Section 4.2.1.  Setting Tabs. 

 Setting the time range on each tab. See Section 4.2.2.  Setting the Time 

Range. 
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4.2.  Creating Filters 

Filters are used in Instant Recall to limit the live record view. A filter is a single 

Channel or Channel Group. Use the Filters Option, Figure 10, to define which 

filters are visible in an Instant Recall tab. 

Figure10. Filters Option 

 

To add a Channel filter, select one or more channels from the Channels list and 

click on the associated arrow button. To add a Channel Group filter, select one 

or more groups from the Groups list and click on the associated arrow button. 

The order in which the filters appear in the Instant Recall tab can be adjusted. 

To change the order of filters, select one or more filters from the Visible list and 

click the up or down arrow to change the relative order. 

To prevent a filter from appearing in the Instant Recall, select the filter in the 

Visible list and click on the Remove Filter button. 

4.2.1.  Setting Tabs 

The most efficient organization for monitoring a recorder with Instant Recall is to 

create one tab per filter. The Instant Recall tab provides a configurable window 

into the activity on one or more channels. For more information about the 

Instant Recall tab, see Section 4.6.1.  Instant Recall Tab. 

4.2.2.  Setting the Time Range 

To set the time range on an Instant Recall tab, enter a value for the Hours and 

Minutes in the boxes at the top of the screen. The Instant Recall tab will 
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automatically refresh the record view. For more information, see Section 

4.6.1.  Instant Recall Tab. 

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

4.3.  Updating Records 

Once records have been located, there are a number of ways to examine their 

properties. From an Instant Recall tab, records can be sorted in any direction 

using any available column. Examine detailed properties for any record by right-

clicking a record and selecting Properties from the drop-down menu, Figure 11. 

Figure11. Instant Recall Menu 

 

4.3.1.  Properties Screen 

The Properties screen lists the attributes of the selected call record and includes 

the following tabs: 

 Properties – provides information about the record properties. See Figure 12. 

 More – allows you to add information about the record. See Figure 13. 

 History – Provides a history of the record. See Figure 14. 

Properties Screen – Properties Tab 

The Properties tab provides detailed information about the record’s location, 

time, and phone. You may add information about the record in the Notes box. 

Check the Protected box in the Attributes section to prevent the record from 

being deleted. 
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Figure12. Properties Screen – Properties Tab 

 

Properties Screen – More Tab 

The More tab includes the custom fields specific to your recorder that contain 

additional information about the record. From this screen, you may edit any of 

the custom field information. 

Figure 13. Properties Screen –More Tab 
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Properties Screen – History Tab 

The History tab provides an audit history of each time this record has been 

accessed, including the related user information. 

Figure 14. Properties Screen –History Tab 

 

4.4.  Viewing and Playing Records 

After you have found and organized records as described in Section 

4.1.  Locating and Organizing Records, you may view and play the records. 

4.4.1.  Viewing Records 

Records are displayed for viewing in the Instant Recall tab and are shown in a 

tabular list. The view can be customized in that it supports a number of different 

column and sorting options. From the record list you can: 

 Play the records. See Playing Audio Records or Playing Video Records. 

 Export the audio or video data to a file. See Section 4.5.  Exporting Record 

Data. 

4.4.2.  The Record View 

The Record view in the Instant Recall tab presents data in tabular format. You 

may sort the information in any way by clicking on the appropriate column 

header. A small arrow will indicate the sort direction. To reverse the sort, click 
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the column header again. Columns can also be reorganized. Click and drag any 

column header and drop it into a new position. The type and number of columns 

can also be customized. Right-click any column and a menu of available column 

names will appear.  To add a column, select it from this menu. To remove a 

column, deselect it. To reset the columns to their user-defined default value, 

select the Reset to Default option. For more information about this, see the 

Default Columns section. 

To play audio or video data in Instant Recall, double-click the desired record or 

highlight the record and press the Enter key. Playback of the audio or video 

data will begin. Instant Recall only supports sequential record playback. For 

more information, see Section 4.4.3.  Playing Audio or Video Records. 

Record View Menu Options 

Selecting a record in the Record view of the Instant Recall tab and then right-

clicking on that record causes the Record View menu to appear, Figure 15. 

Figure 15. Record View Menu 

 

The Record View menu selections include: 

 Properties – See Section 4.3.1.  Properties Screen. 

 Protect – Checking this box prevents the selected record from being deleted. 

 Play selected – Causes the selected record to start playing. See Section 

4.4.3.  Playing Audio or Video Records. 

 Export selected – See Section 4.5.  Exporting Record Data. 
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4.4.3.  Playing Audio or Video Records 

Once you have located records, you have a number of options for playing the 

records. Records are played one record at a time, in the order in which they 

appear in the record list. To change the play order, sort the list of records 

differently. Playback will adapt to the new sequence. 

MediaAgent supports single record playback. Audio or video can be streamed 

from an Eventide recorder only. Audio volume and playback speed can be 

individually adjusted, and seeking random playback positions (“scrubbing”) is 

supported. 

Playback is controlled via the Playback console at the bottom of the screen. See 

Section 4.4.4.  The Playback Console. 

Playing Audio Records 

To begin playing the audio from a record, press the Play button in the Playback 

console at the bottom of the screen. The first record in the list will begin playing. 

To indicate where the playback is emanating from, a green arrow appears on the 

right side of the tab at the top of the screen and another green arrow appears to 

the left of the channel in the Record View. 

Alternatively, select a record and press Enter on the keyboard to begin 

playback, or press the Spacebar on the keyboard to begin, pause, and resume 

playback. Once the first record has been selected, the Spacebar can only be used 

to pause and resume play on that record. To select another record, highlight the 

new record and press the Enter key or double-click on the new record. 

You may also use the sub-menu items in the Playback menu to control playback 

or right-click the desired record and select Play selected from the Record View 

drop-down menu. 

Playback of an individual record can also be started by double-clicking on the 

record. To select another record for playback, just double-click the record in the 

Record view. The record will start playing immediately. 

Playing Video Records 

To begin playing a video record, press the Play button in the Playback console at 

the bottom of the screen. The first record in the list will begin playing. You may 

select a different record from the list by highlighting the record in the list. The 

selected record will begin playing instead. Press the Pause button to stop 

playback and the Play button to resume playback. 

Alternatively, select a record and press Enter on the keyboard to begin 

playback, or press the Spacebar on the keyboard to begin, pause, and resume 

playback. Once the first record has been selected, the Spacebar can only be used 
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to pause and resume play on that record. To select another record, highlight the 

new record and press the Enter key or double-click on the new record. 

You may also use the sub-menu items in the Playback menu to control playback 

or right-click the desired record and select Play selected from the Record View 

drop-down menu. 

Playback of an individual record can also be started by double-clicking on the 

record. To select another record for playback, double-click the record in the 

Record view. The record will start playing immediately. 

When starting playback of a video record, a new pane displaying the video will 

appear in the upper half of the main window above the Record list, Figure 16. 

You may expand this screen by right-clicking anywhere in the video area and 

choosing Detach from the drop-down menu. Once detached, you may expand 

the size of the screen by dragging on its sides. To restore the video screen to the 

upper pane, right-click on the detached screen and select Attach (or click on the 

X in the upper right corner of the screen). 

 Note: You can also increase or decrease the size of the video screen by moving the 

divider bar between the record list and the video display up or down. 

To select another record on the same channel for playback, double-click the 

record in the Record view. The record will start playing immediately. 

Figure 16. Video Record 

 



 

 MediaAgent User Manual v2.1 Chap. 4.  Using MediaAgent    27 

4.4.4.  The Playback Console 

The Playback Console (Figure 17), located at the bottom of the screen, allows 

you to control all aspects of playing records. From the Playback Console you can 

adjust the volume and speed of the record being played: 

 Volume – Use this slider to increase or decrease the output volume of an 

audio record. Moving the slider to the right increases the volume; moving it 

to the left decreases the volume. Pressing the R button to the right of the 

slider will reset the slider to the default position of “0.” 

 Speed – Use this slider to increase or decrease the playing speed of the 

record. Moving the slider to the right increases the speed; moving it to the 

left decreases the speed. Pressing the R button to the right of the slider will 

reset the slider to the default position of “100%.” 

Figure 17. Playback Console 

 

 

The buttons in the center of the console include: 

 Rewind – If playback is less than 3 seconds into the record, moves to 

previous record in the selected sequence. If playback is more than 3 seconds 

into the record, resets to the start of the current record. 

 Play – Plays any highlighted record, or resumes playback after pausing. 

 Pause – Pauses playback. 

 Fast Forward – Moves to the next record in the selected sequence. 

 Loop – Loops playback for the selected record. The loop can be between the 

beginning and end of the record or between the loop boundary settings 

within the record. 

 Slider – The slider on the right side of the console allows you to change the 

playback position. This is known as scrubbing. You can scrub at anytime 

during playback. To quickly move to a different spot within a record, click 

and drag the scrub slider. While scrubbing, keep track of the position by 

watching the playback time indicator. 

You may also click on the double arrow buttons on either side of the slider to 

skip forward (>>) or skip back (<<) by the amount of time defined by the Skip 

Interval option (see Skip Interval). 

While a record is being played, its attributes scroll right to left in the area above 

the playback controls. This information includes recording time, length of the 
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record, the recorder from which the record was retrieved, and the record’s 

channel number. 

4.5.  Exporting Record Data 

MediaAgent can export audio and video data from your recorders in the format 

in which it was recorded. Once records are visible in the Instant Recall tab, 

perform the following: 

1. Right-click on the record that you wish to export. 

2. Select Export selected from the drop-down menu. The Select export file 

name screen, Figure 18, will be displayed. 

Figure 18. Select export file name Screen 

 

3. Using the arrows at the top of the screen, select the directory/folder to which 

you wish to export this record. This information will then be displayed in the 

Look in: box. 

4. At the bottom of the screen, enter a file name for the record in the File 

name: box. 

5. Click on the Save button. An Export progress box will be displayed which 

will indicate the progress of exporting the record. 
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6. When the exporting completes, click on the Close button. The exported 

record will now be saved in the directory/folder that you selected. 

4.6.  Monitoring Recorders 

MediaAgent allows you to monitor the live audio feeds on a recorder. In addition, 

there are tools to monitor channel activity as well as the health and status of a 

recorder. 

4.6.1.  Instant Recall Tab 

The Instant Recall tab, Figure 19, provides a live window into the activity on 

one or more channels. The most efficient method for monitoring a recorder with 

Instant Recall is to create one tab per filter. See Section 4.2.  Creating Filters. 

To open a new Instant Recall tab, select New Tab from the File menu and select 

Instant Recall from the drop-down list. 

The Instant Recall tab’s main controls are positioned at the top of the screen 

and include: 

 A drop-down list of channel filters to narrow the instant recall window. 

 An adjustable time period that allows you to set the time window for which 

records will appear. 
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Figure 19. Instant Recall Tab 

 

By default, Instant Recall will contain filters for each channel name on a 

connected source. (To create customized filters, see Section 3.2.4.  Filters 

Options.) The records displayed in the record view will correspond to the 

selected filter, and will also correspond to the specified time range. 

To adjust the time range, enter a new value for Hours and Minutes. Instant 

Recall will automatically refresh the record view. To change the channel that is 

displayed, select a new channel name from the drop down list. The record view 

will again be automatically refreshed. Alternatively, you can refresh the record 

view by selecting Refresh from the Tools menu. 

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

The Instant Recall record view can be customized by right-clicking on any area 

in the column headers. A drop-down menu with a list of column names will be 

displayed. To add a new column, check the box associated with the column 

name. To remove an existing column, uncheck the box associated with that 

column name. 

Columns can also be re-arranged. To move a column to a new position, click on 

the column header, hold down the mouse and drag the column header to a new 

position, then release the mouse. The column will then re-position itself. 
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4.6.2.  Channels Tab 

The Channels tab, Figure 20, displays all physical channels in a list below each 

source and provides live status information for all physical channels on a 

recorder. To open a new Channels tab, select New Tab -> Channels from the 

File menu. 

Right-clicking anywhere in the screen below the column heads displays a drop-

down menu that includes two items: 

 Group – Checking this box groups the channels by their respective recorders. 

 Filter – Checking this box will filter out all channels that are not actively 

recording and display only those channels that are actively recording. 

If you check the Group by recorder box, each connected source appears in the 

Channels list. Expanding the tree information reveals all channels on the 

source. 

To sort the list of channels, click on the Channel Name or Channel Number 

header; a small arrow will indicate the sort direction. To reverse the sort, click 

the header section again. 

Each channel is displayed with the Channel Name, Channel Number, and 

current Channel Status. To enable live monitoring of the data currently playing 

on a channel, toggle the Live Monitor icon for the selected channel. For a 

channel recording video information, when you select Live Monitor the video will 

be displayed in the upper half of the Channels tab screen. By right-clicking 

anywhere in the video screen area and choosing Detach, you may detach the 

video from the Channels screen and expand the size by dragging any of the 

borders. To restore the video screen to the Channels screen, right-click on the 

detached screen and select Attach (or click on the X in the upper right corner of 

the screen). 

To enable recording on a channel, check the Record Enabled checkbox. If 

checkbox is deselected, any audio or video currently being recorded will stop 

until the Record Enabled checkbox is re-checked. Multiple channels can be 

monitored simultaneously. Adjust the overall volume level for an audio channel 

using the volume slider at the bottom of the window. 
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Figure 20. Channels Tab 

 

The status of each channel is displayed in the Channel Status column. A colored 

square indicates the current status. The colors correspond to the following 

states: 

 Green – The channel is enabled, but not recording any audio. 

 Red – The channel is enabled and recording audio. 

 Yellow – The channel is disabled. 

 Grey – The channel is disabled by the system or is not recognized. Consult 

your system administrator for details. 

You may add more columns by right-clicking on any area in the column headers 

and selecting one or more new columns from the drop-down list of column 

names. Check the box associated with each column name you wish to add and 

the new column will appear in the Channels tab. To remove a column, uncheck 

the box associated with that column. 

4.6.3.  Recorders Tab 

The Recorders tab, Figure 21, displays live drive and alarm information for 

connected sources. Select the recorder from the Sources list to display the 

recorder’s status information. The Drive status reflects the current number and 

status of drives on the selected recorder. As drives are added or removed from 

the recorder, (for example, a network archive) the Drive status list will 

automatically be updated. 
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The Alarms list will display the current active alarms on the source. As new 

alarms occur, the list will automatically be updated. To acknowledge an alarm, 

highlight the alarm and click on the Acknowledge button. Also, consult with 

your system administrator about any active alarms. 

Figure 21. Recorders Tab 
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  

5.  Frequently Asked Questions 

Question Answer 

How can I work with records in Microsoft Excel? Information can be moved from an Instant Recall 

tab to Microsoft Excel using the copy and paste 

commands. In the Instant Recall tab, first select a 

record. Then copy the record to the clipboard. 

Switch to Excel and paste the information into the 

spread sheet. 

Why can’t I use Instant Recall over a larger time 

range? 

Your user account may be limited by your system 

administrator to a specified time window. Check 

with your system administrator. Otherwise, to 

research older records on your recorder, use the 

MediaAgent client application. 

I’ve created a Channel Group for Instant Recall, but 

cannot see it in the Instant Recall tab! Why not? 

After creating a Channel Group, make sure the 

group is also part of the Visible filters. In the 

Options screen, select Filters from the list on the 

left. You will see your newly created Channel Group 

in the Group list. Select this Channel Group and 

click on the right-arrow button to add it to the 

Visible list. This Channel Group will now be 

available to all of the Instant Recall tabs. 

Certain channels from my recorder are not 

appearing in MediaAgent. Why? 

If certain channel name information was recently 

altered on your recorder, it may be necessary to 

restart MediaAgent and reconnect to the recorder 

before those channel names are available in 

MediaAgent. 

I’ve found a problem with MediaAgent. What should 

I do? 

In addition to the Frequently Asked Questions, you 

should consult any release notes for information 

regarding your version of MediaAgent. 

Also, see Section 6.  Reporting Problems. 
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  

6.  Reporting Problems 

It is Eventide’s policy to work directly with dealers, not end users. Your dealer 

must report your problem to Eventide with the following information in order to 

process the service/support request: 

 Serial number(s) of the affected recorder(s). 

 Software versions for both the recorder(s) and MediaAgent. 

 Severity of the issue, including a detailed description. 

 Contact information (phone and email) for the dealer and on-site technician. 

To contact Eventide customer service for support, call 201-641-1200 Option 6 

followed by Option 2 (Communications/Recorders Division) or email 

support@eventide.com. 

 

mailto:support@eventide.com

